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27th June 2010

321 International

Audio-Visual

Gala Day

Aldbourne Memorial Hall, Aldbourne,

Wilts SN8 2DQ

For full details see the EVENTS listing

on Page 4 or contact Maureen Albright ARPS 

Email: maureen@maureenalbright.com

  

DIG Members’ Digital Projected

Image Competition 2010
This is a new venture for the group. All members are invited to enter up to three images,

which should be submitted electronically. There is an entry fee of £5.00 to cover

exhibition costs

The closing date for entries is 30th July 2010. 

Judging will take place in mid August and the results announced at the end of August. An

electronic (pdf) catalogue of accepted images will be made available for download from

the Group Website.

Full details are available from:

http://www.rps.org/group/Digital-Imaging

13th June 2010

Print lecture by Paula

Davies FRPS and Guy

Davies ARPS plus an AV

Presentation by Keith

Scott FRPS

Eversley Park Centre, Low Street,

Sherburn-in-Elmet, LS25 6BA

For full details see the EVENTS listing

on Page 4 or contact Robert Croft LRPS

Email:

monkfryston.photography@googlemail.com
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16th May 2010

Mark Mumford ARPS with "Gorilla

in a Yellow Field"

The Old Schoolhouse, Churchbridge

Road, Oldbury, W.Midlands

time: 10:30AM - 4:30PM

Cost: £7.00

Contact: noel shaw LRPs

Email: midig@nsashaw.co.uk

this meet  ing is to be an inspiring

presentation of surreal photography and

imagery by Mark Mumford ARPs

entitled "Gorilla in a Yellow Field."

Mark has been an artist and graphics

designer, working with Photoshop since

1990. He has his own unique way of

producing surreal landscapes, often using

many layers to build an image from a

basic landscape photograph.  In his

presentation we will see some of his

watercolours, drawings and early

examples of his fascinating Photoshop

work.

Mark will show his surreal visual arts

ARPs panel and his very latest images,

plus demonstrations of how these were

created. the March RPs Journal featured

an article by Mark, "Painting with Pixels"

and reproduced some of his inspiring

pictures. the doors open at 9:30am and

first-come first-served for a choice of

seat!  Coffee on arrival and at lunchtime

is free, there is a bar.  Bring your own

sandwiches for lunch.   the Meeting Fee

is payable at the door.  seats must be

booked in advance by email to noel

shaw LRPs at midig@nsashaw.co.uk, or

'phone 01789 298386

23rd May 2010

"Famous for Five Minutes" and the

Annual D.P.I Competition

Coopers Hill Community Centre,

Bracknell, Berkshire RG12 7QS

time: 10:00AM - 3:30PM

Cost:  £5.00 D.I.Group Members,  £8.00

non members.

Contact: Roger norton

Email: digro@rpsdig-thamesvalley.org.uk

Morning session - 'Famous for Five

Minutes' short presentations by members.

Afternoon session - Annual Projected

Image Competition  

4th June 2010 - 20th June 2010

DIG Print Exhibition 2010

Northlight Gallery, Brooke's Mill,

Armitage Bridge, Huddersfield, West

Works HD4 7NR

the Exhibition dates are: June 4,5 and 6,

11,12 and 13, 18,19 and 20

Cost: Free

Contact: Phil Hack LRPs

Email: philhack@btopenworld.com

the first showing of the 2010 Exhibition

is being hosted by the Yorkshire D.I

Group at the northlight Gallery, which is

open on Fridays, saturdays and sundays

6th June 2010

Informal Meeting

The Greyfriars Community Centre, 44

Christchurch Road, Ringwood BH24

1DW

time: 10:30AM - 4:00PM

Cost: £3.00 D.I. Group Members. £5.00

non-Group Members

Contact: Barry senior Hon FRPs

Email: barry@littlepics.freeserve.co.uk

1. Introduction to the GigaPan panoramic

imaging system

2. Adobe Photoshop 'Hints and tips'

3. 'Be Famous for 5 minutes'. Bring your

work to show. prints, images as digital

files or short Avs.

Bring packed lunch. tea and coffee

available

13th June 2010

Print lecture by Paula Davies FRPS

and Guy Davies ARPS plus an AV

Presentation by Keith Scott FRPS

Eversley Park Centre, Low Street,

Sherburn-in-Elmet, LS25 6BA

time: 10:00AM - 4:00PM

Cost: ticket only event: £6.00 DIG

members £8.00 others - to be ordered

and paid for by 20th May 2010.

Available from Robert Croft, Centre

Coordinator. tel:01977 685262  email

monkfryston.photography

@googlemail.com

A Yorkshire D.I.Group Event day with

Paula Davies FRPs and Guy Davies

ARPs presenting their print talk

"Double Exposure" in the morning, and

Keith scott FRPs with an Audio visual

Presentation and Demo in the afternoon

20th June 2010

Workshop

The Merryfield Hall, Ilton, Somerset

TA19 9HG

time: 10:30AM - 4:00PM

Cost: £3.00 D.I.Group Members, £5.00

non-Group Members

Contact: tony Poole ARPs

Email: tonyfpoole@blueyonder.co.uk

Photoshop and other tutorials in the

morning, Members prints, digitally

projected images and Audio visuals in

the afternoon.

Food available, contact tony Poole to

order

27th June 2010

321 International AV Gala Day

Aldbourne Memorial Hall,

Aldbourne, Wilts SN8 2DQ

time: 10:00AM - 5:30PM

Cost: £8.00 for DIG members (pre-

booked and pre-paid), others £10.00

Contact: Maureen Albright ARPs

Email: maureen@maureenalbright.com

the Judges for the 2010 UK stage will

be: Ian Bateman FRPs MPAGB, val

Rawlins FRPs and Maureen Albright

ARPs DPAGB

Website:http://www.ibateman.co.uk/321/

the challenge for 'Avers' is to make a

short sequence with a maximum

duration of 3 minutes 21 seconds, hence

the title of the competition. the UK

stage will be held in the Memorial Hall,

Aldbourne on sunday 27th June 2010. 

For the 2010 event, the entries will be

judged at various locations around the

world, with stages in France, Belgium,

Italy, switzerland, the netherlands,

south Africa, Canada, Chile, Argentina,

Australia, Mauritius, Germany, Poland,

Oman, Portugal and of course here in

Aldbourne! Equally challenging is the

fact that your sequence will be marked

by judges whose native language is not

necessarily the same as your own!

this year we have changed the format

for the UK event in that the entries will

be pre-judged before the public Gala

show on 27th June. this will avoid the

over-run we had last year, and allow

time for comments from the judges as

well as less ‘down-time’ for the

audience.

tickets available from:

Rodney Deval ARPs,

28 Haywards Close, Wantage OX12

7At

tel: 01235-765259 

Please make cheques payable to RPs

Wessex DI Group

EvEnts
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G
reetings and a very warm

welcome to the spring edition of

‘DiGit’.

this issue sees the change-over of

editorship from Jim Buckley to Dr.

David f cooke.  During his time at the

helm, Jim has made enormous changes to

the appearance, content and style of our

journal.  We owe a huge debt of gratitude

to him as each succeeding issue has gone

from strength to strength.  many Di

Group members tell us that one of the

principal reasons for joining the group is

to be able to receive this quality journal

packed with information that is directly

relevant to them. 

the change-over will appear seamless as

we’ve planned for this over the past year

during which time David has been co-

editing DiGit to ensure the smooth

transition. 

David has many ideas to ensure that

DiGit continues to meet the needs of

our membership and we can all be

confident that the high standard

established by Jim will continue under

the new management.

Does Di make Better Photographers?

in a recent e-mail exchange with a

colleague as part of an on-line image

appreciation group, the question was

asked, ‘has digital technology made us

better photographers?’ as you might

expect, there’s certainly no ‘yes or no’

answer.  one thing’s for certain, it’s

encouraged us to be both more prolific

and experimental. another plus point is

the immediacy of Di as an aid to the

business of learning about photography. 

it is, however, appropriate that we should

take a moment to consider the question,

has it made us any better? to begin, let’s

look at the question in a different way.

have power tools made better

woodworkers? as an example, take the

production of an elegant chair as once

designed and hand-made by Sheraton.

original design and concept apart, it

must be efficient to use modern tools to

more speedily produce a chair of this

type. and once the method has been

recorded step-by-step it would be

possible, with sophisticated machinery, to

build an assembly line to manufacture

many clones of the design. one benefit

of the technology would be to reduce

unit cost so that many more people

could afford a Sheraton chair. on the

minus side, the chairs would lack those

subtle nuances that would naturally

occur as a craftsman painstakingly

hand-crafted each one with due regard

to wood type, grain and texture. in the

same way, hand-prints from the same

original negative by ansel adams and

printed by the master himself subtly

changed over time as he explored

nuances within the scene and how he

wished it to communicate.

Digital photographic technology

presents us with a highly accurate

recording device whereby we can make

high-definition reproductions of what is

in front of the lens. however, it takes a

real seeing-eye and a master craftsman

to turn the subtleties of light, shade,

form and line into works of art. if we’re

making a print, we can add our choice

of paper to further influence the

outcome, a far cry from the days in the

darkroom when paper choice was

limited.

So to attempt to answer the question. at

the craftsmanship level we’re probably

no better in terms of concept, vision and

hands-on skills, but the technology has

enabled many for whom working in a

smelly and chemical-ridden

environment was impossible or

undesirable, to realise their visions.  in

this way Di has both liberated and

enfranchised people. What we must

endeavour to guard against is the

reduction of personal style and

expression by resisting the temptation

by the ‘press a button for a quick fix’.

each scene we capture has a unique

combination of structure, tensions, light,

form and possible narrative and just like

Sheraton or ansel adams we must

remain responsive to such intrinsic

qualities, otherwise, yes, we will be the

poorer. While art and craftsmanship take

time, new tools allow us to be more

efficient but they should not become our

masters.  as artists and photographers,

we must remain in control and at every

turn, seek to realise our vision.

from the chairman
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J
  ust get fifteen good prints and

arrange them. That’s all there is to

it. oh, if only. 

My agony began years ago when i

thought rather like that. i certainly

thought i had offered enough good work

to gain an ARPs  but the RPs didn’t and

my hopes were dashed. i was in despair.

ecstasy would have to wait. Life’s little

incidences prevented another attempt for

several years. however, when i decided

to take early retirement i realised that i

could focus on my life-long love of

photography. But by now everything

had changed, so, where to start?

first some very basic courses in digital

photography and then more specifically,

with the more advanced cs2. i also

joined two photographic organisations

and my steep learning curve had begun.

After one particular course on Black and

White photography, which included

toning, i produced the lily (image 13 in

the panel) which did well in local

competitions. i was very pleased with

my progress.

This triggered a few ideas for an ARPs

panel, so i went to a distinctions

workshop to see if my ideas were at

least acceptable. The first of my three

ideas involved the lily and other flowers,

then possible images with poetry and

even a panel about trees. All were

definitely fledgling ideas with only a

few images in each but they all got the

basic go ahead. i felt that i was back on

course.

After a visit to the cambridge Botanical

gardens i had a few more interesting

Janet davies tried to gain her ARPs several years ago but her first attempt

was unsuccessful. Many years later, she was able to try again and this time

she succeeded. in her article, she describes the process she went through in

achieving her goal.

The Agony And ecsTAsy of

gAining An ARPs

Tulip
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images which helped me to decide that I

would work on my flower portfolio using

my newly acquired macro lens. They

also reminded me of the work of Georgia

O’Keefe. At the same time, this is where

the agony began to show itself again.

One judge was overwhelmed by one of

my images of a rose (image 2 in the

panel) and gave it full marks with tears

in his eyes, declaring it to be absolutely

beautiful. Another declared that he did

not like “arty farty” images and it fell to

the bottom of the pile, a virtual zero.

Once I got over the hurt feeling, I was

fuming. I intended to show him that he

was wrong.

My search for flower images began -

flowers in situ, in the kitchen, in

England, in France, in fact, anywhere,

using natural lighting. Gradually a style

was developing, although I had not yet

even thought of putting it into words. I

just knew when a new image fitted with

the others. Then I entered a panel of four

flowers into our local Annual Exhibition

which was Commended and my lily, as

an individual print, was Highly

Commended. I was now beginning to

think that I could do it. I had glimmers of

hope in my eyes.

The layout of the successful panel

Statement of Intent

The Beauty of Flowers

“What is this life if, full of care,

We have no time to stand and stare?”

      

The verse of this poem, “Leisure”, indicates my intentions with this panel.

There are subtle tones and shapes within flowers, that we simply do not

notice as we become too absorbed with our daily lives.

These are “bee’s eye images”! The peculiarities and the textures of each

flower are so familiar to the bee. We need to put ourselves in his position!

“Every flower is

A beautiful masterpiece

Winged or blossom stemmed.”

When we get this close, there is so much to see, that we have to slow down

to appreciate what is there, to become more peaceful and, possibly, even to

meditate, thinking how quietly they have grown to bring us such beauty and

perfume.

“A poor life this, if, full of care,

We have no time to stand and stare”

Quotations are from W.H.Davies, Dorothy Holmes and Megna Kalvani.
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Several more months passed before I

saw an accessible Distinctions

Workshop. Accessible, as I am a cyclist,

not a driver, so need to use public

transport for long distances. I decided on

fifteen images, stuck them onto white

card with blu tack (I wasn’t going to

waste card if my work got the thumbs

down). I had some spares in a folder on

a slightly different theme. Much to my

surprise, the reaction was WOW! Just

go for it! Could it be that easy?

I decided not to tell anyone about this

workshop or anything that had been

said. I was pleasantly shocked at their

kind words but also came home with

lots to think about. The prints may have

been acceptable but I was advised to

consider carefully the colour of the

mounts, the photographic paper, the

length of my statement, the way of

mounting etc. Many things indeed, but I

sent off my entry form to make myself

continue. This was the point of no return

and the time when the hard work really

began.

I started with the colour of the mount

board buying six near white shades and

carrying them home in the wind! I tried

out various images on each colour and

decided on Champagne White. I decided

to get ten sheets as each sheet would

make two mounts and that would mean

five spares. Surely that would be enough!

Unfortunately that colour needed to be a

special order with a week of waiting but

at least it would be delivered. No

struggling in the wind this time.

Now onto the paper experiments. Having

previously tried a black and white tree

Lily

image and brightly coloured leaves on

various textures, I was lost. I simply

could not see the point of textured

papers. I needed advice, provided by a

member of the Digit website. The most

important fact I learned was that textures

are best for pastel images and limited

tonal ranges. I chose seven textured

papers from a mixed box and test printed

four different flower images on each. At

long last I could appreciate the

difference. I had truly been given good

advice. I decided on Textured Art Silk

which was not available locally so I

ordered a box of fifty sheets. That would

be more than enough for fifteen prints;

wouldn’t it? An average of three sheets

for each image as composition, print

profiles etc had already been decided.

While mount board and paper were

slowly winging their way to me, I had

other decisions to make. My prints were

landscapes, portraits and one square.

Two landscape versions were virtual

letter boxes and I had a selection of

main colours. I did my best to arrange

them, balancing all necessary factors and

then realised that I had to choose either

portrait mounts or landscape mounts

rather than mix them for better

unification of the whole panel.

Landscape won the day. Another hurdle

had been cleared.

Now with all decisions made and all

items delivered, I could proceed to the

printing stage. I ordered myself to go

slowly, triple checking everything as

costs were escalating, and my sturdy

printer was showing signs of faltering.

Sometimes it would shoot a sheet of

paper straight through without printing;

at other times it would need as many as

four head cleans before it was ready.

There was no way I was going to change

printer now. It had been profiled and had

been a good friend for three or four

years. I would cope somehow. I will

spare you that trauma but eventually it

was repaired, after my application had

been completed.

I did manage to print all fifteen images

leaving eight sheets of paper in the box;

no problem there then. Now to the

mounting which I intended to do

extremely carefully. So why did I cut the

first one far too big? I could not believe

my eyes. The hole was too big. I had

wasted one whole mount. I resorted to

quadruple checking for each stage and to

aim for just two to be completed in one

session. After what seemed like months,

08,09 DIGIT Spring 2010 Janet Davies:448-471 Talbot  05/05/2010  09:09  Page 1



9RPS DIGIT Magazine Spring 2010

Orchid

Camrose

the mounting was completed with two or

three weeks to spare.

Only the Statement of Intent to go! Only?

NO! I needed to check the whole layout,

so I took the whole set to a large room

and laid it all out. No way did the two

letter box ones fit. Either the shapes

balanced or the colours did, but definitely

not both. I needed two more prints with

two weeks to go. A recent judge had

praised another flower image, so I was

sure that would fit but I felt I needed

white for the other one. It had to be white

to get the balance right. It seemed that all

of the flowers I could see were brightly

coloured and a touch of panic was

beginning to surface before I finally

found some white chrysanthemums.

Producing the necessary image must

have taken about two days and, what felt
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­like,­hundreds­of­images,­before­I­felt

satisfied.

Now­the­final­printing­for­the­last­two

images­with­only­eight­sheets­left.­I­did

tests­on­my­usual­paper­and­then­one­of

each­on­the­Textured­Art­Silk­and­they

looked­great.­What­a­relief.­However,

when­I­went­to­mount­them­on­the

following­day,­in­a­different­room,­in

different­lighting,­I­could­see­printing

faults.­I­knew­how­few­sheets­I­had­left

and­definitely­began­to­sweat.­I­doubted

if­I­could­get­a­new­order­through­in

time.­Great­care­was­needed,­starting

with­four­head­cleans­and­using­a

magnifying­glass­to­check­each­print.­By

this­time,­you­could­say­I­was­becoming

neurotic­but­I­did­get­the­two­final

images­printed­with­two­sheets­left­in

the­box.

Of­course­I­had­only­mount­board­left

for­three­more,­so­I­was­OK­with­two­to

do.­Well,­yes­…­but­then­the­double

sided­tape­decided­to­fool­me.­It­seemed

there­were­several­metres­left­when,­in

fact­there­were­only­about­ten

centimetres!­The­time­on­the­clock

registered­as­4.45pm,­nearly­closing

time.­I­left­everything­where­it­was,

grabbed­some­money­and­my­keys­and

raced­to­the­shop.­Thank­goodness­they

are­reliable.­I­bought­the­tape,­raced

home­and­completed­the­job.­Now­I­was

as­happy­as­I­could­be­with­the­printing,

mounting­and­the­layout.

On­to­the­last­task?­The­Statement­of

Intent.­I­re-read­it­and­chopped­it­down

to­about­forty­words,­the­bare­essentials.

I­did­not­like­it.­While­it­was­factually

correct,­it­just­did­not­match­the­flowers.

Pause­for­thought;­perhaps­some­poetry

would­help.­The­W.H.­Davies­poem­was

very­familiar­and­a­family­favourite­but

I­needed­more.­Thank­goodness­for­the

internet.­After­a­search­for­flower­poetry

I­eventually­found­a­suitable­quote­and

felt­much­happier.­I­reviewed­the

statement­the­next­day­and­made­a­few

minor­adjustments­before­printing­it.

Everything­was­actually­ready­with­two

days­to­go.­I­could­relax.

RELAX?­But­what­if­?....

Delivering­the­portfolio­on­time­was

straightforward.­Now­for­the­first­time­I

realised­that­other­people­were­at­least

as­nervous­as­I­was.­That­downstairs­loo

was­in­constant­use!

The­room­where­the­assessment­was­to

take­place­was­filled­with­eager­but

nervous­or­even­petrified­entrants.­The

Fresia

Blue Flower
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chairman explained very clearly the

procedures for the day, mentioning,

among other things, that 40% seemed to

be the usual pass rate. My heart sank,

less than a 1 in 2 chance! I picked up the

crossword section of my paper in a

desperate attempt to concentrate on

something.

There was a deathly hush as the

proceedings began. The first portfolio

was displayed, discussed and given the

thumbs down, as was the second, third,

fourth … I lost count! By lunchtime, the

majority were not successful, including

one flower panel. I was worried.

However, those that were successful

were clearly acknowledged and the

applicants were suitably congratulated if

they were present. Everyone was pleased

for them; we all knew what was

involved.

Magnolia

Gladioli
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The waiting was horrendous. As each

new set of work appeared my heart rate

rose in expectation and then sank as it

was someone else’s work. Another

flower panel was unsuccessful. Anyone

got any tranquillisers? I even wondered if

anyone had actually had a heart attack

while waiting. I began to think it was less

stressful to go to the dentist!

My heart rate must have gone off the

Richter Scale as my work appeared. Had

I really done all I possibly could?

Someone sitting near me, said it was

good; she liked it. The seconds seemed

like hours until the chair said the decision

was unanimous! I was absolutely

stunned. He asked if it could be kept for

a workshop but I wasn’t going to let go

of it that easily! I wanted to show people

what I had been doing and why I had

been so tetchy at times over the last few

months. Only two non-photographic

friends knew what I had been doing. 

Soon I would receive that very important

letter, saying that I had been successful.

Sorry, but the email was not solid enough

for me to announce it to the world!

After a week the letter did arrive. Now I

could tell everyone. It became the top

item on our society’s website and I

received lovely emails and phone calls

from many friends and acquaintances.

Even Waitrose assistants had seen me in

the local paper and wanted to add their

congratulations. The ecstasy had finally

come and I could show people what it

was all about. Everyone seemed to be

thrilled with what I had achieved, using

words like stunning and exquisite. I had

not realised how much it meant to me. I

Pink Dahlia

kept getting quite emotional. Surely I

could relax and return to normal now?

Or could I? At least three people have

suggested that I now start on the

Fellowship. How very nice of them to

say so, but, not yet. I think I’ll do

something relaxing like watching TV,

studying Higher Maths or even

mountain climbing! In fact, anything

that might just return my stress levels to

normal.

Was the ecstasy worth the agony?

Oh,YES! Quite definitely. I loved my

Five Minutes of Fame (a bit longer

actually) and hope that other people can

learn from my story, as I return to my

usual anonymity.
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I
n this second part of my article on

Photoshop Actions, I will describe

how to write a simple basic but useful

action to Flatten Layers, and an action to

create a pseudo infrared effect and colour

popping

Flatten Layers.

The action described below is an

introduction to action writing/recording

and is most useful in it's own right.

Actions do not have to be long and

complicated and often a simple one, as

described below, will have frequent use. I

rarely print an image without, at some

stage, using layers or adjustment layers.

These have to be flattened ultimately.

This action simply flattens the layers and

adjustment layers and avoids the need to

navigate your way to the "Flatten layers"

command.

To create the action :-

1. Open a file.  Make a duplicate layer. In

the layers palette press "Create new

action" button (see last article in DIGIT).

Name it “Flatten layers” and set function

key to (say) F11  (never F1 or F12).

2. Layer > Flatten Image.

3. Stop recording. Save the action.

Close the image which was used only to

create the action.

In future, whenever an image file

containing layers needs to be flattened,

simply press the nominated hot key you

have chosen, and the layers will be

visibly flattened without having to do it

all by keystrokes. Hidden layers will be

discarded.

Pseudo Infra-red and colour popping.

Recently in DIGIT, excellent articles

have been written about modifying

digital cameras to record infra-red light.

For several years, since CS3 was

released, I have been using the “black &

white” adjustment to create a similar

Actions are a very useful feature in Photoshop which can save you a lot

of time. In this second of a two part feature, John Wigmore continues his

explanation of the benefits of actions. This article follows on from part 1

(DIGIT, No.43, pp13-15) which covered the basic techniques. You will

find a downloadable copy of the article in the DIGIT magazine section

of the DIG Forum.

effect; before that, I used channel mixer.

The following describes how to create

the action which I have made and which

is available for download at http://

sites.google.com/site/digitdownloads.

Typically IR images have almost black

(blue) skies, light grass and foliage, and a

degree of halation (flare, diffusion)

around the highlights with crisp grain

(noise). By no means all images will

respond effectively to the Pseudo IR

treatment, but when they do you will be

in for a surprise! 

Method.

Note: Steps 1 to 4 below inclusive will

often give a suitable B&W effect but

steps 5 onwards will help refine the

effect and make it look more like infra-

red film.

1. Load image file. I suggest a picture

with grass, blue sky and white clouds.

This can be sharpened either before or

after using the action. Press "z" for

zoom.

2. Start recording. Ctrl + "j" to duplicate

the background layer to give "Layer 1".

3. Layer > New adjustment layer >

Hue/saturation or click on 4th from left

icon bottom of layers palette and select

hue/saturation.  Set saturation to +30 and

accept. This intensifies the effect.

4. Layer > New adjustment layer > Black

& white.  Set values as follows: Red

+175, Yellow +175, Green zero, Cyan -

24, Blue -48, Magenta +80.  Accept.

5. Layer > New adjustment layer >

Curves (or from layers palette icon).

Name it "Lighten Strongly" and use the

following values :- 0 , 0 ; 58 Input , 139

output ; 255 , 255.  

Don’t worry about the shape of the curve

which will rise steeply and level out

across the top. It is used to lighten very

dark areas (like conifer trees) which

sometimes render much too dark.

6. Fill the layer mask with 100% black

(Edit > Fill Black 100%).

7. Make a blank layer (Layer > New

layer  or Ctrl + Shift + "n"). Change the

blend mode from Normal to Overlay

and click once into a blank area around

the image. (see part 1).

8. Name it "Local darken/Lighten" by

double clicking on the words "Layer 1"

and typing in the new layer name then

press "Enter" to accept.

9. Press "b" for brush.

10. Stop recording. (First button on left

at the bottom of the actions palette.

11. Add one or more "Stop messages"

(see Part 1)  and type the appropriate

instructions. Tick the continue box at the

bottom. (see the downloadable action for

my wording).

12. Start recording again (Actions

palette 2nd button from left at the

bottom).

13. Flatten the image.  (Layer > Flatten

image).

14. Duplicate the (now) background

layer (Ctrl + "j") and rename it

"diffuser" (see 8 above).

15. Set blend mode to "lighten" from

normal and set the opacity to 85%.

16. Filter > blur > Gaussian blur 10

pixels (or to your taste, but try 10 first!)

and accept..

17. Make a blank layer (Ctrl + Shift +

"n") and fill it with 50% grey (Edit > fill

> grey 50% normal). Accept.  Change

blend mode to "Overlay" from "Normal"

and click once into a blank area around

the image  (see part 1 as before).

18. Add noise (Filter > Add noise

>Gaussian 30% Monochromatic).

Accept.

19. Stop recording (see 10 above). 

PHOTOSHOP ACTIONS

PART 2

Photo by Eileen Wigmore
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20. Add a suitable "stop" message. Save

the action.

Now press F12 function key to revert to

your original image, change the actions

palette to button mode (tiny arrow at the

top right and click on Button mode).

Click the button for your action and

watch it all happen!  If all else fails, load

the downloadeable action, and look to

see where you have gone wrong!

To adjust the tonal values, click on

"Black & White" adjust layer to activate

it and double click on the two semi-

circles to the right of the "eye".  The B &

W adjust layer palette is now displayed

and the sliders adjusted to give the tonal

values desired.  Making the blue and

cyan values less (more minus value) will

darken skies. Conversely increasing the

red, yellow and green values will lighten

grass and foliage (except conifers). Press

OK to accept your new values.

If you wish to colour pop part of the

image, paint black into the B&W layer

mask at (say) 50% brush opacity, to

lighten conifer trees paint white at 10%

brush opacity into the layer mask for

"lighten strongly" by clicking once into

it's layer mask to activate it. By painting

black or white 20% brush opacity into

the blank layer (Local darken/lighten)

you can do just that!  If the effect is too

strong reduce the opacity of your brush

or use  Edit > Fade brush tool (Ctrl +

Shift + "f").  Mistakes can be corrected

by painting the opposite "colour" i.e.,

black over the white and visa versa.

As we are using adjustment layers, all

tonal values in all areas can be fully

controlled.

Lastly, go on to add the diffusion and

noise, flatten (use the  action given at

the beginning of this article)         , save image

and enjoy your masterpiece.

Rosedale Pseudo IR with popped colour

Wast Water Pseudo IR
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In part 1 (DIGIT No 43, pp 16-17) I

discussed the historical use of lith film

for producing derivatives and how to

emulate this in Photoshop. Some images

will benefit from having white clouds

instead of a black overall sky. 

The action required to do this is

described below. The action differs

considerably from the one mentioned in

Part 1 in its actual adjustment layers, so a

brief description is necessary here but

because you are by now familiar with the

way to create layers and adjustment

layers (see Part 1) the method will not be

described in such detail.

Note that some values are minus figures.

1. Make background duplicate layer (Ctrl

+ "j") and name it "Interneg".  Change

the blend mode from "Normal" to

"Overlay".  Invert this layer.

2. Make an adjustment layer "black &

White" clipped to the Interneg layer. Red

-200,  Yellow -200,  Green -200,  Cyan

+200,   Blue +200,  Magenta +80.

New members should read John Wigmore’s article “Digi-Lith” Part 1 to

get the necessary background information. Both this and the action

described here can be downloaded from:

http://sites.google.com/site/digitdownloads/

3. Make the adjustment layer "Selective

color" with the following values (all

absolute ) - Red colour ... Cyan  -100.

Green colour ... Magenta -100.     Cyan

colour ... Black +100%.     Blue colour ...

Black +100%.

4. Duplicate this adjustment layer by

CTRL + "j".

5. Make adjustment layer

"Hue/Saturation" and set Cyans to -52

Lightness and blues to -100 Lightness. 

6. Add adjustment layer "Levels" so you

can adjust the overall tonal range to suit

with the middle input slider perhaps at

0.75.

7. Insert a "Stop" message with

"Continue" as below  “Done!” Adjust as

necessary e.g.,  alter  red & cyan values

in the "black & white" adjustment layer.

Also, duplicate the selective colour

adjustment layers and tweak colours in

the hue/saturation adjustment layer.

CONTINUE for Bas Relief effect ..."

8. Select the "interneg" layer and apply

the offset as in Part 1 and a final "Stop"

message  eg., “Done!” ... flatten image

and save".

Different images will almost certainly

need different values within the

adjustment layers but the presets I have

used will form the basic settings which

you can adjust to taste by clicking on the

black & white semi-circles icon(s) next

to the "eye" of the relevant adjustment

layer.

If a monochrome looking sky is not

liked then a deep blue can be obtained

by switching off the Hue/Saturation

layer and duplicating (CTRL + "j") the

Selective Colour layer.

Grass & foliage often become an

unusual colour and white clouds may

become grey. Much depends on the

tonality of the original file. It is often

worth experimenting with RAW

conversions of differing density

especially with white clouds being

rendered only just off pure white. Like

all special effects, this "Lith with white

clouds" action will only give good

results with the right image. Not all

images will benefit from lith or bas

relief treatment.  If only there was a

magic bullet.

“DIGI-LITH” PART 2
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martin Addison is a fairly recent convert to Lightroom and he is very

enthusiastic about the program. In his article he explains just why he

thinks it is so good and why he believes that many other photographers

could also benefit from using it.

An InTRODUCTIOn TO

ADOBe LIghTROOm

Figure 1: The Library Module

B
efore I introduce Lightroom, I

want to go back to my early days

of digital photography. I was

using colour slides (remember them?)

and scanned the images into Photoshop,

this was Photoshop 4 and I used the File

Browser to find and manage my

pictures. Later on I bought a digital

camera and using RAW files, the process

was basically the same, with File

Browser having changed to Bridge and

the addition of the Camera Raw step.

Photoshop of course got more and more

sophisticated as time went on. The

process I used was to import my pictures

into Bridge, open the ones I wanted in

Camera Raw and then on into Photoshop.

It worked OK and I was used to it, but it

was hardly a smooth process, and was

often laborious when trying to open up

several similar pictures to decide which

one to use. Until I started using

Lightroom I didn’t know that there was

an alternative that was better in every

way.

The clever people at Adobe realised that

the process was not ideal and that

because Photoshop was used by so

many different people, graphic

designers, artists, architects, 3D artists,

moviemakers etc, what was needed was

a more streamlined approach tailored

specifically for photographers. That
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Figure 2: The Library Screen with One Picture Selected

necessitated a complete rethink, asking

themselves what was the ideal workflow

from a memory card of RAW images at

one end, right through to whatever output

was required; print, internet, slideshow or

into Photoshop for finishing. It should be

said that apart from the brilliant

cataloguing system, which is completely

new, there is very little that cannot be

achieved in Bridge/Photoshop, the

difference is that in Lightroom every step

has been redesigned to work together in a

smooth and flexible manner.

Lightroom is split into five sections:

Library – where all your photographs

are stored.

Develop – this includes all the Camera

RAW controls which are in Photoshop.

Slideshow – where slide shows can be

created.

Print – the brilliant printing section,

from where I now do nearly all my

printing.

Web – here you can build web site pages

from the supplied templates.

Starting with the Library section, this is

where the program is totally different to

Bridge. Bridge is a file browser. You

images and it took around 10 days,

doing a few batches each day. Before

you start importing images into

Lightroom it is worth spending some

time in reviewing where you store

pictures, I moved them all to one big

drive and backed them up to another big

external drive, this gave me immediate

access to all my digital images and at

the same time provided good back-up

should a drive fail (which it did two

weeks later).

Once the pictures are in the catalogue,

you can view your entire collection very

easily and very quickly as the catalogue

with data and previews is kept separate

from the RAW files. By the way

Lightroom can also handle JPEGs, PSDs

and TIFFs.

Figure 1 shows the Library module, on

the left is the list of folders, these

correspond to the folders on my

computer which are named by date so

that they appear in date order, click on a

folder and the contents show in the main

window. The film strip along the bottom

of the screen also shows the contents of

point it at a folder on your computer and

it shows you what is there. If you have

the pictures backed-up on a DVD that are

no longer on your computer, Bridge

cannot show you any thumbnails until

you load the DVD back in again.

The Lightroom Library is not a file

browser; it is a sophisticated cataloguing

program. This means that you have to

import pictures into Lightroom and

thereafter it will show you the images

even if they have been subsequently

moved from your computer. This may

sound strange to a Bridge user, but it

works very simply, you put your memory

card into the card reader in the usual way,

click Import in Lightroom and the

pictures will be copied from your card

onto your computer and at the same time

will be entered into the Lightroom

catalogue. When you first start using

Lightroom you will need to import your

existing pictures into the catalogue, this

is very easy to do, but can take some

time. The method is to point Lightroom

to the folders where your pictures are

stored and it will automatically catalogue

them for you. I imported almost 50,000
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Figure 4: The Develop Module

    the selected folder and is present in all

the modules. Below the Folders are the

Collections, these are brilliant for

selecting and keeping together sets of

pictures, for instance you could have a

folder for Competition pictures and

whenever you find something which may

be a possible candidate, just drag and

drop into that folder to review later.

Other uses might be collecting pictures

for a book project or lecture. Lightroom

does not physically copy the picture, but

creates a link to the original so this does

not take up computer space. I use

Collections a huge amount, some folders

last just a few days, while others are

permanent.

Figure 2 shows the screen with one

picture selected.

On the right at the top is the Histogram

for the selected picture; underneath are

several tabs the top one of which is

Quick Develop which allows adjustments

to be made to single or multiple images

without going to the more detailed

Develop module. This is useful for

making exposure or colour adjustments

to a batch of pictures.

There are many layouts available in the

Library module, Figure 3a shows the

Survey mode where several pictures can

be seen together, this makes choosing the

best one much easier, just click the small

x in the bottom corner of one of the

pictures and it will be removed from the

display, the others will shuffle around to

fill the space. Figure 3b shows the

Compare display where pictures can be

compared to find the best version; in this

case I have enlarged the displays to

show greater detail in the eye, this is just

one of many different ways to compare

pictures.

Also on the right panel are the palettes

for Keywords and Metadata, these allow

you to apply keywords to individual or

groups of pictures and then to find them

easily from tens of thousands of

pictures. It might sound daunting to

apply keywords retrospectively to a lot

of images, but there are quick ways of

doing this and it is well worth the effort.

The keywords can be organised into

folders, for instance a folder titled

Flowers could contain dozens of sub

folders for individual species, so you

could easily view all the pictures of

Sunflowers no matter when they were

photographed or where they reside on

your computer or back-up disks. There

are other more advanced ways of

searching, for instance by capture date,

camera, lens type and many more; these

require no input from you as the

information already exists in the

Metadata.

Having selected and possibly done some

alterations to the pictures you can then

either progress to the Develop module

for more work, open it in Photoshop as a

PSD file, or Export it as any type of

image file. The Export function is

superb as you can create and save

templates, for example I have a pre-set

to resize competition pictures at the

correct dimensions, another to send

Figure 3a: The Survey Mode Figure 3b: The Compare Display
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pictures over the internet, another which

resizes and uploads a picture direct to

Flickr and many more.

Turning now to the Develop module,

Figure 4, this contains all the controls

which are in CS4 Camera Raw and it is

worth mentioning at this point that

everything that is done in Lightroom is

totally non-destructive so can be undone

at any time. As you can see the layout is

similar to the Library module, top left is

the Navigator and underneath are the

Presets and these are really very useful.

Some presets come with the program,

others can be downloaded from the

Internet and you can also create and save

your own. Clicking on a preset applies a

set of instructions to the picture, for

example it might lighten the picture,

desaturate the colors, soften the detail

and apply a vignette to make a very

delicate version. All this can be undone

of course and underneath the Presets is

the History panel; unlike Photoshop this

history stays with the picture forever as

everything is non-destructive, that also

applies to any Snapshots made in the

panel below.

On the right hand side are the Camera

RAW controls, these are very similar to

Photoshop so I won’t go through those

now, suffice it to say that they work

superbly and once again presets can be

created for the Develop tools. I

particularly like the ability to click in the

picture area and change

exposure/colour/hue/saturation just by

dragging the cursor up or down, it is very

intuitive and self selects similar tones or

colour on which to apply the adjustment.

Also included here is the Cloning tool, a

Gradient tool which is excellent for

darkening edges and the Local

Adjustment brush which is great for

painting changes onto your picture. The

Gradient and Local Adjustment brush

will apply Exposure, Brightness,

Contrast, Saturation, Clarity and

Sharpness adjustments to areas of your

picture, all at the same time if required.

Figure 5 shows the Before and After

mode where you can see the changes you

are making with the adjustment controls,

as always there are many ways that these

can be viewed, side by side, top &

bottom, split screen, full picture or

magnified etc.

Figure 6 shows the Slideshow module,

not a lot to say about this, just that it

works well and templates can be saved so

sharpening to the paper type and choose

the paper profile. Then save this as a

template in the left panel. From now on,

every time you want to print a picture

on this paper at this size all you need to

do is to click the Print One button, that’s

it – nothing else to do, it prints

immediately and much faster than from

Photoshop as Lightroom prepares the

file exactly how the printer requires. The

output sharpening takes into account the

printing size, resolution and paper type

and adjusts the level of sharpening

automatically.

that you can make a slideshow to your

own specification in seconds.

The Print module works just brilliantly,

so much better than Photoshop which I

now rarely use for printing pictures. Not

only does it make the whole process

much simpler, but I am getting better

quality prints than ever – not entirely

sure why!

The process is simple, click the Print

Setup button and set the printing

resolution, paper source, paper size etc,

then in the right panel set the size you

want to print on the paper. Set the output

Figure 5: The Before and After Mode

Figure 6: The Slideshow Mode
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Figure 8: The Web Module

Figure 7 shows the Print module when

using the picture package section, here I

have selected 12 RAW files in the

Library section, swopped to the Print

module and clicked a preset, all I have to

do now is to press the Print One button

and 12 pictures will print on 3 sheets of

A4 paper, all centred and ready to cut.

Amazing!

The Web module takes the web facility

from Photoshop and improves it

considerably. Figure 8 shows one of my

web pages in the process of being

created. When I want to create a new

web page, I select the pictures in the

Library module (NEFs, PSDs or JPEGs)

put them in the order required, flick to

the Web module and select a template

which I created and saved previously. I

add the new text and headings and then

click Export; this will create the

thumbnails, resize the larger pictures,

create a slideshow and the html and save

it on a specified folder on my computer.

Everything is done in just a few minutes

and it is then ready to be linked to my

home page and uploaded. It makes the

whole process so simple.

My new web site was created using

Lightroom, take a look at:

http://www.martinanddoreen.co.uk

In this article I have only touched upon

some of the many features of this

wonderful program which has

transformed the way I use my pictures.

It is a joy to use and at less than half the

price of Photoshop a real bargain.

Figure 7: The Print Mode
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T
he photographic world has

undergone a vast upheaval in a

very short space of time. Many

technologies have become obsolete and,

as a result, it has become more difficult

(and sometimes impossible) to continue

to create works of art without mastering

new technologies and skills. 

The good news is that all that wealth of

experience in understanding images,

light, shadow, colour, perspective, depth

of field, etc are still relevant. The only

thing that has changed is how we apply

all of this knowledge and what is

presently ‘acceptable’. Every single

The fundamentals of photography, art, and good literature do not seem to

change but the methods and processes that are used to create such work do

change along with our ‘present’ tastes. Gwynn Robinson considers how

such changes affect our photography and the opportunities we have to be

creative.

aspect of our life experience has been

affected by the huge and rapid advances.

We need to keep up with ever advancing

technology to remain ‘current’. This is

easier said than done. The last 100 years

has seen our lives transformed (and not

always for the better). The pace of

advancement also seems to increase

relentlessly. We don’t have the luxury of

‘standing still and remaining current’.

The cameras that we use are no longer

film based, but they do effectively have

the same controls that function in

essentially the same way and it’s not too

hard to remember to insert memory

cards, rather than film. The process of

capturing images has remained much the

same as it was before.

There are some differences that can

baffle some people. Like the number of

menus and sub menus on all cameras.

But in general the changes offer

valuable assistance and dramatic

improvement. For example, the instant

feedback of the captured image on an

integral screen and the ability to swap

settings (eg ISO) on the fly, to name just

two. 

The real problem seems to lie in the

processing of images, transfer to

STARTING OUT - KEEPING UP

Defending our Wealth of Experience
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computer, development, printing, and

back-up.

I have heard of people using memory

cards like film. Using them once and

keeping them (not reusing them). In

some ways as the price of memory cards

has now become so trivial it does start to

make some sense.

I have heard of people not knowing

where their images are stored in their

computers. They have no understanding

of the concepts of folders and files. One

person I know deleted all of his original

images, keeping just the thumbnails. He

thought they were the same and it did not

matter to him which set of them he

deleted, until later on! 

I have heard that many people overlook

opportunities to produce the best possible

quality in their images because they do

not understand how to use the

applications on their computers.

Are the new advancements the problem?

No. They are the solution. The problem

lies in a lack of understanding. Where

can we go to gain an understanding of

the technologies and applications that we

need to use? 

The internet is full of incredibly useful

information, but it can be hard to view

and take in, especially for beginners.

Worse, it relies on the ability to use the

computer to even get to the information.

Much of the available information is

complex and can easily put off someone

new to photography. Be aware that some

of it can be just plain wrong or out of

date.

Books can help but they can be too

general and too simple. They can also be

at the other extreme and be too technical.

It can be hard to find a book that will

suit.

Photographic societies, up until recently,

have been slow to accept ‘the new’ but I

now notice that many are offering

technical evenings. A great idea, but

limited in time so that only a small

number of issues can be dealt with at any

one session.

So what to do? There is a solution but it

is a bit painful at first.

It’s the same solution that I give

everyone when they ask how they can

take better images. Yes certainly, read,

ask; go to society meetings but far more

importantly, get out there and take

photographs.

So here I offer the same advice: get out

there and play with your computer, its

Developing Headache

applications, and your images. Keep the

master copies of your images safe

somewhere (so you don’t lose them) but

try to transfer them yourself to your

computer. Ask your colleagues if you

don’t know how. Try to get your images

into an application and have fun with

them. See what works and what doesn’t.

It won’t destroy your original images as

you have them safe. Write down what

works for you. If you get stuck then ask.

Keep going until you develop your own

skills and feel comfortable with them. It

can be hard work, confusing too at first.

Persevere, as the results of being able to

do whatever you can imagine, are

immense.

Email contact with your societies experts

would be a great help and I encourage

all societies to set up and communicate a

list of members with expert skills

together with their email addresses to

allow members access to a larger

breadth of expertise, knowledge and

help.

A skill is not just the ability to struggle

through. It starts with competency.

Competency is the mastery of the

fundamentally essential elements for

your art. Skill is an extension of this as it

is the ability to weald your competency

with ease to achieve your vision to the

highest quality attainable.

There is a final skill that is very difficult

to master and one that we all trip over. It

is the skill of understanding the ever

changing ‘present fashion’ in imagery.

Identifying what ‘good’ means today is

essential.

Take digital/creative/manipulation as an

example. Some years back, before

digital photography, manipulation was

difficult to achieve. Few ventured down

that route. Very few examples of image

manipulation were seen in competitions.

Then the age of digital arrived and

suddenly everyone seemed to be

manipulating images. Unfortunately

many over did the fiddling and a wave

of negativity towards digital

manipulation grew. That wave has now

largely subsided as the image makers

have become more sophisticated and

their images more subtle and supportive

of their subjects. So the present fashion

in photography is embracing digital

manipulation.

Changing fashions also have had the

effect that previously good work (eg

beautiful landscapes) can now fail to

impress as the judges (and audience)

have seen it all before, and to a veryWhat to do Before it’s too Late
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Forget the Fashion Just Look at the Style

high standard too. So the world of

photography is constantly looking for the

innovative, for novelty and for the next

best thing, redefining ‘good’ /

‘acceptable’. 

For a beginner this is a very scary thing

as the path they are stepping onto is

already speeding away in an unknown

direction. 

Photography is a journey, as I often say.

You will have to travel your own path of

learning and discovery, gaining your own

set of skills that will enable you to

innovate and to take photography to a

new level.  You have to have the courage

to step onto that speeding path and keep

going. You have to have the

determination (and time) to work hard at

developing your skills to new and higher

levels. Along this journey you will also

develop your own photographic style –

way of seeing, capturing, developing,

presenting your work.

Most of us don’t achieve the highest

levels of artistry. We produce excellent

images, we produce interesting work, but

most of us rarely produce great, world

class, winning photographs. And that is

the constant challenge: to step up to the

plate to try, and then to keep trying,

doing new things as the fashion changes,

constantly learning.

How do we develop the skill of knowing

and understanding the changing world of

‘image fashion’? This is done by seeing

presently award winning works of others.

It is also achieved by entering

competitions ourselves and learning from

criticisms. 

Be aware that even judges’ views change

with time. They too grow and develop

and learn. So their taste will change too.

A good way of keeping up with the ever

changing judges’ taste might be for your

photographic society to create and

communicate a list of the known judges

along with their presently known tastes

and types of work (which will influence

their taste).  

If a skill is needed but not mastered, the

result is always frustration and a poorer

result. How do we develop the skills that

we need to remain ‘current’? We need to

get out there, take photographs, fiddle

with the computers and images, enter the

competitions, join a society and attend

their meetings, help each other by

sharing our experiences (good and bad),

spread the knowledge, see what is doing

well, listen to the criticism, and above all

enjoy getting involved. 

A final bonus: because technology is

constantly changing and improving we

can look forward to a lifetime of

newness, enjoyment and increased

ability.

We can All make it Together
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S
harpening is frequently essential;

however it can cause a variety of

problems.

Sometimes the sharpening is simply

overdone and the image appears

unnatural by virtue of its over sharp

definition. At other times the sharpening

process also enhances (sharpens)

unwanted areas and sections such as

'noise', 'film grain' and skin texture

(exaggerating blemishes and being

generally unflattering).

Something can be done to 'fine tune' our

sharpening technique by applying

Clive haynes continues his series on sharpening methods in Photoshop.

This time he describes a method of sharpening the edges of objects in an

image rather than applying ‘blanket’ sharpening to the whole image.

sharpening to the 'edges' of objects and

areas rather as a 'blanket' to the whole

image.

described below is a method that will

enable you to control how much

sharpening you apply and address

principally 'edges'.

We'll be using the 'find edges' filter in

combination with the 'Unsharp Mask'

filter.

The example image for this sequence is

'Spidermen', a picture i shot on a cold

dull day at iSO 500 1/1000 sec at f9.0.

As you can imagine there is a little

ShArPening edgeS

SPeCifiCALLy

Spidermen

'noise' in the sky and other areas - not

much perhaps and barely discernible to

the critical eye at 100% (Actual Pixels,

Ctrl+ Alt+0) display on the monitor. My

task is to sharpen the rope structure and

some other edges without sharpening

any 'noise' in the sky.

1. Open the picture as a Background

Layer

2. Make a copy of this layer, placing it

on the layer above

3. Click on the Adjustment Layer icon at

the bottom of the Layers Palette and

from the drop-down Adjustment Layer
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Figure 1

menu choose Channel Mixer. (Figure 1)

4. Next: The Channel Mixer Adjustment

Layer must be made as a 'Group'

(sometimes known as a 'Clipping Group')

with the layer beneath, for Photoshop

'CS' versions, use Shift+Ctrl+G as a

Quick-Key. For earlier versions hold

down the Alt key whilst passing the

cursor between the two layers

(Adjustment Layer & Copy Layer) in the

Layers Palette, when you see two

overlapping circles appear, left click, and

the upper and lower layers will be

'clipped' together. 

Figure 2

When 'Grouped' (or 'Clipped') a

downward arrow will be shown in the

upper layer. 

NB If 'Grouping' ('Clipping') is not done,

the Channel Mixer setting will affect all

layers beneath and not just the one you

wish to alter! 

5. In the Channel Mixer dialogue box,

click 'Monochrome' (Figure 2)

6. Adjust the sliders to give as much

contrast as possible between the areas

you wish to sharpen and those you don't.

Do this by the Red, Green and Blue

'sliders' (Figure 2). 

Figure 3

Figure 4

Figure 5

7. At this point we’re working on

contrast separation and the effect upon

image content isn’t important. When

you're happy, click 'OK' (Figure 3).

8. Don't forget - this is an Adjustment

Layer so when you wish, you may

return to it again to refine the adjustment

made.

9. Activate the copy layer (Figure 4)

10. Go to Filter > Stylise > Find Edges

(Figure 5) and the filter is applied

(Figure 6)

11. Next, go to Filter > Gaussian Blur >

Figure 6
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1 to 2 pixels (Figure 7). This small

amount of Gaussian Blur is to remove

tiny amounts of stray selection detail

(Figures 8 & 9).

12. Image > Adjust > Invert to make a

'negative' version. (Quick Key: Ctrl + I)

(Figure 10)

13. Should you wish to be selective about

what you sharpen at this stage, use black

to paint-out areas not required for

sharpening 

14. Go to the Channels Palette

15. Click on the 'Load Channel as a

Selection' icon (Figure 11)

16. 'Marching Ants' appear (Figure 12)

Useful Tip: Go to the 'Select' menu -

choose 'Save Selection' and name it (so

you can find it again should you need it)

17. Return to, and activate, the (original)

Background layer - This is the layer to

Figure 9

Figure 7

Figure 11
Figure 8

Figure 10
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which the sharpening is going to be

applied (Figure 13)

18. The work on the (copy) layer above

has been to 'find' the edges, separating it

from the noise or grain (Figure 14)

19. Switch off (click on the eye) the

upper, copy image, layer - you don't wish

to 'see' it - it has done its job!

20. Hide the 'Marching Ants' by Ctrl + H

21. Go to Filter > Sharpen > Unsharp

Mask > adjust to suit

That's it - only the edges will have been

sharpened, leaving grain & noise

unsharpened. The saved selection is

available for further use. An example of

the improved edge-sharpening is shown

as a detail in Figure 15.

My website has information about this

method and other useful techniques,

visit:  http://www.crhfoto.co.uk

Figure 13

Figure 12

Figure 14

Figure 15
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Background

Google “dark prints” and you will be

overwhelmed by the number of forum

postings. I have an Epson R2400, and I

first experienced this problem when

upgrading to  Adobe Photoshop CS3

using OS X 10.5 (Leopard). Prints from a

colour managed workflow were

considerably darker than expected from

the monitor.  In my case, a brightness

increase of about +100 was needed to

achieve an acceptable print (Figure 1).

The problem also manifests itself when

attempting to produce test charts for

profile production. 

Roger Norton has experienced problems with prints produced from a

colour managed workflow being much darker than he expected. He

investigated how he could prevent this. Here, he gives details of a work-

around to solve the problem.

In an attempt to identify what was going

on, I printed a 21-step monochrome

wedge (in RGB) using both CS1 and

CS3. There was a considerable difference

in tones, the CS3 wedge being much

denser especially in the mid-tones. I

scanned the printed wedges into

Photoshop and measured the densities of

each step using the eye-dropper with the

Information palette set to “total ink” as a

surrogate for density. The results were

plotted against the values for the original

file (Figure 2); this shows the huge

difference in printing from CS1 and CS3.

The absolute values for the

THE DARK PRINT PROBLEM:

A REMEDIAL WORKFLOW

Figure 1: Simulation of Print and Monitor Image

measurements are approximations due to

the scanning stage, but the comparison is

still valid.

The strange thing is that not everyone

seems to experience the problem and,

equally strangely, some people are

having problems with other combinations

of software including OS X 10.5

(Leopard), OS X 10.6 (Snow Leopard),

Microsoft Vista, and with other Epson

printers. I do not know whether  Canon

or HP printers are affected. The

phenomenon affects both Photoshop CS3

and CS4 but, apparently, not earlier

versions.
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Figure 2: Densities (Total I nk) of Step

Wedges

There is no simple explanation for this,

but Mark Dubovoy (writing for The

Luminous Landscape,

http://www.luminous-landscape.com/

tutorials/solving.shtml ) suggests that

the printing process has been

compromised by “double profiling”.

Dubovoy states “if you are using an

Epson printer and Apple computer with

the latest operating system, the latest

version of Photoshop (CS4) and one of

the latest Epson drivers, you cannot print

a file with no color management. I know

that this sounds almost absurd, but it is a

fact”. He, in collaboration with contacts

at Adobe and Epson, has given a

technical explanation of what is

happening and, more importantly, gives a

'work-around' for preparing profile test

charts which I have used successfully.

This is reproduced below.

So we can now print profile test charts,

but what about images? Here, I am

indebted to John Read (Marrutt Ltd.)

who talked me through (by telephone) a

printing workflow which now gives me

an excellent print to monitor match.

The Work-Around for Profile Test

Charts

Open the untagged profile target image in

Photoshop CS4 and select Edit > Assign

profile and select 'Adobe RGB'  (Figure

Figure 3: Assigning Adobe RGB

3). This is the first departure from the

normal practice of printing an untagged

file. The choice of Adobe RGB is not

essential; other colour spaces such as

ProPhoto RGB would suffice provided it

is used consistently.

Select File > Print, followed by setting

color handling to 'Photoshop Manages

Colors' and the printer profile to 'Adobe

RGB' (Figure 4). This is the second

departure; normally color handling

would be set to 'No color management'

and the option to choose a profile would

Figure 4: Setting Colour Management and Profile

28,29 DIGIT Spring 2010 Roger Norton:448-471 Talbot  05/05/2010  15:19  Page 2

29.67 cm x 20.99 cm 

300 
£l 
C 250 ·c 
a. 

al 
C 

200 
C 

l'3 
~ 

150 

.:,,'; 100 .s 
~ 
{!. so 

Missing Profile 

50 100 150 200 250 300 350 400 

Total ink (original file) 

The document "TC9.18 RGB il(A4)_1_3.tif" does not have an embedded RGB 
profile. 

What would you like to do?-------------------, 

0 Leave as is (don't color manage) 

0 Assign working RGB: Adobe RGB (1998) 

Q Assign profile : I Adobe RGB (1998) 

and then convert document to working RGB 

: I 

( Cancel ) (..___O_K _ _,) 

nnt 

Prlnttr: [ EPSON Stylu• Photo R2400 ; I Gt" 

Copies: IC"] 

( ColorM1.na9e.ment : )------~• 

0 Document 

(Profile: Adobe RG8 (1998)) 

Q Proof 

<Ptoffl• N/AJ 

Color Handling: 
r- - - - - - - - - - - - - - - - - - - - - ,.;, • ..-,..~""'''' - - - - - - - - - - - - - - - - - - - - - , 
: --···-.-·····----- : 

( Page Setup ... ) [jg 
,, 
:, ,, 
:, 
" ' ,, 
" ' ,, 
:• .. 
' , .. 
:Q 
'" :" .. . .• .. 
' , . ... . 
l 4 1 (.t t e .. tl • \WIIIO•Oetl I 

~------------------------------------------ --·---~ 

0 Match Print Colors 
0 Gamut Warning 

0 ShowPaperll'hlte 

Position----------~ 

~ Cen~u Im.age-

Top:1 

lefc I 
_, 

Scaled Pront Size-------~ 

0 Sale to Flt Medi• 

Scale: j 100ll: =:I j 
Htlght: p 7.29 =:I ~ 

IV'idth: ._!2_6._24 ___ _.l 
Print Re,olutlon: 101 PPI 

0 Bound,119 Box 

Units: (._cm ___ l'-:...,1 

( Photosho;, Manogu Colors : I 

<D Remember to dinbte <Ofor rmna.gement 
In th• printer diolog box. 

Printer Profile: 

( Adobe RG8 (1998) 

Rendering Intent: 

[ Re1.ativt CoJorimetric 

0 Slack Point Compen .. tion 

Proof Setup: 

~ - Lyson_R2~00_PG9P 

'J Stmulate P•per Color 

"$ S1mul>te 8lo<~ lnl< 

:J 

( Cancel ) ( Done ) ( Print ... ) 



RogeR NoRToN lRPs

30 RPS DIGIT Magazine Spring 2010

be greyed-out.

Next, set rendering intent to

'Relative Colorimetric' and

uncheck black point

compensation. Now select 'Print'

to open the printer dialogue and

select Printer Settings from the

drop-down list. Set Color

Settings to 'Off (No Color

Management)' and choose the

appropriate paper type (I use

either Premium Lustre Photo

Paper or Archival Matt) plus

other settings that you normally

use when printing, and print

(Figure 5).

The Work-Around for Printing

Images

The most important factor in

achieving a good inkjet print is

the use of a calibrated monitor,

preferably one calibrated with a

colorimeter rather than visually.

The first step before opening an

image is to check that

Photoshop's colour settings have

been set-up correctly.

Select Edit > Color settings.

Under working space, RGB

should be set to Adobe RGB

(1998) when making prints. The

dialogue box should appear as in

Figure 6. If, on opening the

image, it has the incorrect profile,

the profile mismatch dialogue

will appear and the profile should

be converted (Figure 7).

Go to Page Setup and select the

printer, paper size and

orientation. Select File > Print

and under color handling, select

“Photoshop Manages Colors' and

the appropriate paper profile.

Figure 5: Printer Dialog Settings

Figure 7: Profile Mismatch

Figure 6: Color Settings
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Figure 9: Print Dialog (Epson R2400)

Figure 8: Print Setup

Uncheck black point

compensation (Figure 8).

Select the Print button to enter

the printer dialogue. Select the

paper type and the normal

settings such as 'Best Photo'.

Under Color settings, choose

Adobe RGB (Figure 9). This is a

departure from normal practice

which would require the setting

to be 'Off (No color

adjustment)'. Select Advanced

Colour settings and ensure that

Gamma is set to 1.8. And now

print your image.

And that is it. I am none too

happy about using work-arounds

but they work for me. Hopefully,

software updates will be made

available in the future that

overcome these problems. In the

meanwhile, I hope that these

work-arounds will help others to

emerge from the frustration that

I have been experiencing.

RPS DIGIT Magazine Spring 2010
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W
ay back in historical times at

School of Architecture in

1934 I needed a camera and

commenced making pictures. War came

and after five wasted years followed by

another nine achieving recovery, I

bought an Iloca f2.8 c/r and some

kodachrome 1  (8 ASA). I was in

photography proper again, became

Chairman of a small club, then member

of Stockton Photo Colour Society.

One night in 1958 a Lecturer sponsored

by kodak gave us a projected

Ray Wallace Thompson was most surprised to see an article on

Anaglyph Stereoscopy in DIGIT (“Making 3D pictures The Red / Cyan

Method - Anaglyph” by Clive Haynes. DIGIT No 44 pp18 - 22). It

prompted him to write to recount his experiences of stereo photography

over the last 50 years.

Stereography show  using that wonderful

polarising filter material invented by Dr

Land.   The pictures were all in natural

colour and projected using a twin lens

projector with shunted Land material.

They were viewed  using  viewing

spectacles with corresponding shunted

polarised material.

That lecture was cunning.  It showed

buildings, people, scenes, animals etc.

As an Architect, to see buildings ‘in the

solid’,  was a seller and I resolved to use

it.  By chance my Photographic Dealer

LOOkING AT STEREO

PHOTOGRAPHy

Victorian Street, Preston Park Museum, Stockton on Tees 

and I were close friends and he  obtained

an Iloca stereo camera for me. In those

days, when we sent a film for

processing, we just cut off a corner of

the return address and it came back

rolled.   On a 36 shot film we got 24

stereo pairs.

Mounting was done by using aluminium

4” Realist Standard mounts which set

the viewed stereo window at 6’0”. Using

this system the nearest homologues

needed to be no nearer than 62.25 mm

and the distant ones in infinity no further

apart than 63.5mm.  If the near ones

were closer then the subject came

forward from the viewed frame. This

was effective if, for instance, one had an

elephant reaching out its trunk. To see an

audience reach up and pat it was

amusing.

Soon my Dealer found a Duplex stereo

projector. Unfortunately it was a hot

runner and a slide burner but I was

buying lots of electric fires in those days

and the manufacturer made me a small

balanced fan which I built into a base

and we succeeded in giving stereo

shows. Simultaneously my Dealer friend

heard of the late Bob Nightingale who

had a precision engineering works in

Ilford. Bob was a stereo fanatic and built

a stereo projector, I was able to buy the

second one he made, the Hawk Mk1.

Having the stereo camera allowed me to

quickly build up a first stereo lecture in

1962 using the Duplex and a tape

recorder. This was entitled ‘Intro to

Stereo’ and was shown over fifty times,

the furthest away North being at

Dumfries CC  and the furthest South

being to the Colour Group of the RPS in

London.   Obviously it helped build up

interest and we had 25 members

working in Stereo.

At this time I was also Editor of the

Photocolour News and was awarded two

silver bowls for World top status in PSA.
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Sir Nigel Gresley on the North Moors Railway

This brought contact with many stereo

workers in other countries.  

Lecturing taught us a  lot. One night a

viewer passed out during a show and

others complained of eye strain/ache.

This led to discussions with a family eye

specialist and, of course, the realisation

came that stereo pairs must be mounted

dead level. Therefore  I drew up a design

for a mounting jig which incorporated

both a horizontal line and also vertical

pairs set at the magical homologue

separation distances. It was then

necessary to make a datum slide and

using it to set the lenses with each

following slide  corner shimmed to agree

and messing about with the projection

controls was then dispensed with.

Naturally there were a fair number of

others so involved and one outstanding

one was the late Phil Shenton of

Richmond (the new one near London)

who built a stereo camera using lenses

which were ground to sit nearer together

than the norm. This enabled close up

stereo shots of nature subjects,  This was

copied by the late Dr Mrs        M P

Whitehouse whose stereo essay ‘Salute to

Handel’ is still, today, recognised as

superb.

In 1964 the stereo members of the Colour

Society became dissatisfied with the

Group’s  treatment and at the proposal of

one member the Third Dimension

Society was formed.    I  became

Chairman, Lecturer and Editor, the late

Jim Milnes continuing as Exhibition

Organiser, Lecturer and Secretary. Within

weeks we were International, PSA

registered and with many members at

home and abroad.  I edited the magazine

and with it won a couple of PSA silver

plates with consequential further

contacts.

In those days we communicated with

snail mail and when we sent glass

mounted stereos, particularly in shows, it

was a slow and expensive business

although occasionally we used 5” tapes.

We were often experimenting into

unknown areas and many interesting

results came along.    I recall the late Lee

Klinefelter of Norfolk, Virginia, handling

variable distance control.  He and I also

experimented with quadraphonic sound

to accompany stereo pictures, and

eventually we came across simulated

quadraphonics by Scandyna (I think of

Sweden) and the results were  quite

fantastic (I still have this).

The Third Dimension organised

conventions, in conjunction with the

Stereoscopic Society. The last one I

attended was at Matlock. It was a very

large gathering. One night Dorothy and I

shared dinner with the then head of

Kodak in Europe and we discussed what

seemed to be threatening our current

hobby.  Both of us could see a change

coming and he opined that he could see

Kodak limiting production of slide

material.  He is still a senior PSA man

and still strongly stereoscopic.

I found entering exhibitions in addition

was time consuming and expensive and

this limited my activity,  although I did

acquire two stars.   The potential

presented by stereo was seized upon

enthusiastically and exhibitions began to

over-appreciate technique rather than

picture. During those early days Dorothy

and I had a big four bedroomed house

and had folks from other countries

dropping in to meet me. I was a Chief

Officer in Local Government and

frequently worked a six day week,

occasionally seven. Pressures began to

tell, and in 1968 I had to limit button

pressing severely for just over ten years

whilst retaining membership of all

Societies and Clubs. Retirement 31

years ago allowed re-entry.  The  Third

Dimension continues locally and

internationally but the Colour Society

has shrunk.

One obvious danger in lecturing with

Stereo is the fairly large number of

people having ocular troubles.  Often I

had folks saying they had eye ache, even

though I knew the  slides were

accurately mounted and projected. In

fact my Dorothy simply refused to

watch my shows and this prompted me,

nearly twenty years ago, at the age of

75, to re-consider where I was heading

photographically.  

The first casualty was those twin

projectors, although  slides and a good

scanner saw a few shows being

digitalised onto discs. Then Stereo.

Heart breaking but needed.

Producing stereo images

It is possible to try out stereo easily without buying a new camera. This is by way of a

slide bar. The bar needs to be of flat aluminium, say about 8mm wide and long

enough to take camera plus a trapped hole to screw onto a tripod head. A slot is

formed 7.5 mm long to pass a camera base screw. Mounted ready to use one can only

take static subjects and the two pictures ta  ken can be at varying inter-ocular distances,

I have shot ultra close-ups of blooms at 1 to 1.5cm spacing between shots and

produced a stereo picture of what a bee sees.

Naturally one wishes to see the results and, if these are printed and mounted level, it

is possible to look at them at a comfortable distance, but instead of focusing on the

prints look through them and, if your eyes are normal, you will ultimately get a third

central stereo picture. This is ‘free viewing’.
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White Lily Colour Popped by Janet

Haines LRPS. Some beautiful pure

white lilies sat on the table just begging

to be photographed.  I relished the

challenge of getting a good textural shot

with no burnt out highlights, as so often

happens with white flowers, so I plonked

them on the kitchen floor and positioned

my lighting.  I stood them on a sheet of

black mount board to ensure no

distracting background. a series of shots

were then taken using aperture priority,

ISO 100 and my macro 105mm nikkor

lens.  But once in the computer I was

disappointed to see a noticeable pink

caste on the shots, this being reflected

colour from my shocking pink kitchen

walls.  Photoshop to the rescue.

this time we have four more images from dIg members who explain how they created them.

I hope you’ll find these interesting and helpful techniques to use in your own photography. If

you do, why not join in and me send some of yours?  email me at:

davidfcookearps@gmail.com.

Initially I thought I could overcome the

problem by adjusting the channels, but

this did not give the required result of

displaying this pure white lily to best

advantage.  So using a couple of layers I

proceeded to make the top layer a B&W

version by desaturating, then adjusting

the levels till I got a good crisp feel to

the petals, showing the desired textures.

Using a mask on this layer I then elected

to colour pop the stamens through from

the lower coloured layer, to bring

through the delicate green stems and

red/brown crowns.  having flattened the

layers I did a minor crop on the lhS to

marginally improve the composition and

with the addition of fine black and white

borders it was finished.  

the dIgIt challenge

The Final Image

Original image with Colour Cast

So the question is this....... does it meet

my original criteria?  I will leave you to

judge that for yourselves.  What I learnt

from it was to n   ot use my pink kitchen

as a studio!
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helenium by david askham. As a

regular contributor to the RPS Digital

Imaging Group Forum I have noticed

that post-processing with artistic plug-ins

is very popular. “Buzz” has assumed a

legendary role despite it being no longer

available. I decided that before exploring

the 3rd party alternatives, I would

experiment with some of the native

Photoshop filters. Thus it was that my

picture ‘Helenium’ was offered for

comment on the forum and I was invited

to write about my technique.

Oh dear! All I had was the original image

file and the small web-size derivative

seen on the forum, plus the vaguest of

recollections of my methodology. So here

is my attempted reconstruction.

1. I opened the TIF file, made a copy,

changed to 8-bit and resized it for

publication. (Not all filters work in

16*bit mode).

2. I opened Filter>Artistic>Dry Brush.

Brush Size 2; Brush Detail 8; Texture 2.

Already there is an amazing

transformation.

3. I then added noise (filters>Noise>Add

Noise>Gaussian) setting 7.16%.

4. The central flower cone was selected

and lightened in Levels to reveal subtle

detail.

5. Deselect.

6. Filter>Texture>Grain: Intensity 26;

Contrast 58; Grain type Soft Filter>

Texture>Texturiser Canvas: Scaling 70%

Relief 5 Light Top Right.

7. At three stages, I adjusted Hue /

Saturation with final settings: Master

Saturation +15; Yellow channel Lightness

+8; Red channel -23.

8. Select All, Edit>Stroke 4px black.

9. Deselect.

I was not seeking ‘over-the-top’ effects

because I try to remember that my

starting point is a photograph and the end

result should still look like a photograph,

albeit modified.

The procedure may seem complicated,

but it only took about fifteen minutes of

reconstructed experimentation. 

Would a plug-in be easier? Possibly, but

I have no basis for comparison.

Somehow I doubt it. However I do

know that there are infinite variations of

artistry possible in Photoshop to keep

me busy for a very long time.

Meanwhile, I may make a print for the

wall!

The Original Image

The Final Image

gp capt david askham obe, raf ret’d
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Money For Nothing by Dr Ria

Mishaal Cooke LRPS. I had a vision of

this image in my mind’s eye and went

out in search of it. I wanted to create

something dark and edgy that

approached the topic of our

technological age and the waste that

often results. So, I went to my local

civic amenity site and captured the

original image.

1. I began by opening my RAW image

in Adobe Photoshop through Camera

Raw. 

2. My first manipulation involved

selecting the whole image and

transforming by applying ‘distort’

(through the Edit menu), to give the

final perspective. 

3. I then applied a new layer and

'selecting all layers' I used the clone tool

at a variety of opacities to get rid of the

columns and the sign and to stretch out

the wall at the top.

4. I then created the atmosphere by

applying two Color Efex filters (Color

Efex is a Nik software plug-in for

‘Money for Nothing’ Final Image

‘Money for Nothing’ Original Image

Photoshop): Midnight, which adds the

dark moodiness, and Bleach Bypass

which increases local contrast adding

texture. I applied these filters by

brushing them in and out of different

regions until I got the effect I wanted. 

5. Finally, I used Viveza, another Nik

software plug-in, which utilises the u-

point technology seen in Capture NX.

This allowed me to apply points to the

centre of the image where I increased

the brightness and contrast.
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Tomato Sandwich by jim clark. This

was made from two images sandwiched

together, hence the title. The first image,

a close shot of tomatoes, was selected

and the second image of fruit and

vegegetables in baskets was copied and

Tomato Sandwich: Final Image

First Image: Tomatoes

jim clark

Second Image: Fruit and Vegetables

pasted over the first image.  The two

images were the same size. In the

Layers palette I used “Color” Mode and

also put a bit of Gaussian blur (about

10%) onto the image which was then

Flattened. Voila! Tomato Sandwich.
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T
he convention for HdR (High

dynamic Range) photography is

to take three, or more,

photographs of a subject with three

different exposures and then combine the

three images together to make a full

range HdR photograph. The

disadvantage of this method is that it can

only be fully accomplished if there is no

movement between the three exposures

and while a tripod and rapid fire shooting

can sometimes achieve this there is no

way, in normal landscape work, where

this can be realised because there is

always some movement taking place,

even if it is only the leaves and grasses in

the view. 

In digital photography the use of the

RAW image setting overcomes the

problem of movement because a single

RAW image can be made into three or

more images with any exposure you

wish, to capture the best possible HdR

outcome. One of the big advantages of a

digital RAW image is that the exposure

can be changed after the photograph has

been taken and thus, the three separate

exposures required for HdR can be made

from one single shot. What is more, the

original exposure of a RAW image can

be as much as one-and-a-half times over

exposed and yet not only can the burnt

out highlights be recovered, but by

making such an exposure, the shadows

are much more open with very

considerable reduction in noise and

moire effect found in under exposed

shadow areas of digital images.

The technique is to shoot landscape

photographs in RAW with perhaps two

or more in rapid fire but one of the

images is set to over expose by as much

as one-and-a-half times. The resulting

images are downloaded on to an Apple

mac computer and into Apple Aperture

 It is possible to create High dynamic Range (HdR) images from a single

photograph but often the resulting image is rather flat and an increase in

contrast, if not a boost, is needed. Here, maurice Baker explains a method

of achieving this.

ver. 2.1.4. Images can of course be

manipulated this way in other RAW

processing programs including

Photoshop. The RAW image (usually the

over exposed image) has two further

versions (copies) made and these copies

have their exposures adjusted so that, one

image has a ‘good’ exposure, one is over

exposed to reveal the shadow area details

and one is underexposed to reveal all the

highlight detail, particularly in the

clouds.

The three adjusted images are then

loaded into Photomatix, (an HdR image

processing program) that makes a good

job of assembling and processing the

images into HdR. The resulting

assembled HdR image shows a much

increased tonal range over the original

image and seems to have taken the best

aspects of all three images, but invariably

the final result is rather flat and a

contrast adjustment, if not boost, is

usually called for. 

The contrast control procedure is to open

an image in Photoshop and make two

contrast layers. One is to manipulate the

highlights and the other to manipulate

CReATING HdR ImAGeS

fROm A SINGLe

PHOTOGRAPH

the shadows. By working in this way not

only can much greater control be applied

but there is no chance of any colour shift

during or after the procedure. 

The method is to have the image open in

Photoshop where contrast adjustment is

needed and the Layers palette on the

right hand side of the screen (if the

Layers palette is not open go to

Windows and click layers in the drop

down menu). 

Then:

1. In the Channels palette click on the

RGB while holding the Ctrl key, (this

will change the pointing finger to show

also a small square) then return to the

Layers palette

2. Click the half black circle icon at the

foot of the Layers palette called ‘Create

new fill or adjustment layer’

3. Select Curves from the drop down

menu

4. At the central 50% point click down

to 30% (assuming % is set use

Shift+page down to move 10% per

click). Click OK

5. Name layer H (it works on the

Highlights only)

The opened H Curves Palette The opened S Curves Palette
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Original overexposed RAW Buttermere View Processed HDR image Buttermere View

Original overexposed RAW Tarn Processed HDR image Tarn

Original overexposed RAW Beck Processed HDR Beck

6.  Copy this layer by dragging it to the

second icon from the right (Create a new

layer)

7. Ctrl+I to make it a negative mask

8. Name this layer S (it will only control

the Shadows)

9. At the central 50% point click up 10%

to 60% click OK

To get even more out of the layer masks

it may be necessary to:

10. Alt+click on the H layer mask (it will

turn monochrome)

11. Go to Image >Adjustments >Levels

(top tool bar)

12. Clip in both black and white ends to

accentuate the contrast

13 Click the ‘eye’ box on the H layer to

take the image back to colour

14. Do the same for the S layer mask.

By taking this action the contrast of the

image will be improved considerably and

it is still possible to go back into the

Curves layers and make further contrast

adjustments to both the Highlight and

Shadow layers.  This facility of using

layer masks has been available since very

early editions of Photoshop. In later

versions an Action script can be made so

that it is only necessary to click a button

and the contrast adjustment will be made.

Actions can also be setup for 10%

increasing Highlight mask and 10%

decreasing Shadow mask. All of this

work is fully explained by Guy Gowan

who approaches Photoshop in a

completely different way to almost

anyone else and yet it is all just what

photographers need to know. He has a

web site http://www.guygowan.com

and I recommend that you look at the

site and, perhaps, consider investing in

membership where so many controls in

Photoshop are fully explained and all

work is within Photoshop without

having to resort to plug-ins.
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W
elcome to the 8th edition of

Webwise. This time I’ve got

information on sites for

downloading textures and Photoshop

Actions and well as on how to get

information on old cameras and

manuals for them. If you do decide to

download any of these be sure to read

the terms and conditions or stipulations

by the owner before using them in your

work.

Photoshop Action sites
In his two articles on Photoshop Actions

(‘Actions 1’ on pp 13-15 of the Autumn

2009 Issue of DIGIT, No 43, and on pp

13 and 14 of this issue), John Wigmore

explains how to make Actions and

provides downloads of those he has

described. There are also a number of

Websites where you can download

actions. If you are interested in finding

actions specifically aimed at

photographers then I suggest that you

type ‘Photoshop actions for

photographers’ into your favourite

search engine. I did this in Google and

came up with a long list. Some of these

actions are free and some you will need

to pay for. Given the multitude of sites

and of the interests of different

photographers, it is virtually impossible

to recommend a specific site but, when I

did my search, the sites with five star

reviews on Google were:

The Photo Argus

http://www.thephotoargus.com/
freebies/100-outstanding-
photoshop-actions-to-enhance-your-
photography/

Smashing Magazine

http://www.smashingmagazine.com/
2008/10/20/the-ultimate-collection-of-
useful-photoshop-actions/

Designm.ag

http://designm.ag/resources/
photoshop-actions-touchups/

Textures
You can also download textures from

the web for use in your photography. A

Google search on ‘free textures’

produced even more sites than the

‘Action’ search did. The following sites

seem to me to have a good range of

textures which you may find interesting

CG Textures
http://www.cgtextures.com/

which allows free use of the textures,

WeBWISe 8
but there are some limitations so read

the licence agreement carefully before

using them.

Texture King
http://www.textureking.com/

GR Sites
http://www.grsites.com/textures/

and “100 Beautiful Free Textures” from

Smashing Magazine
http://www.smashingmagazine.com/

2009/02/06/100-beautiful-free-

textures/

are also worth looking at.

Old camera manuals
Many of us have old cameras and other

photographic equipment and we have

lost, or perhaps never had, the

instruction manuals for them. If you are

in this position and would like a copy of

the manual then help is at hand at:

OrphanCameras.com
http://www.butkus.org/chinon/

where you’ll find a very comprehensive

range of manuals. I found a manual

there for an old Agimatic Agilux camera

I used more years ago than I care to

remember. You can download the

manuals free of charge and the site

owner asks that you consider giving a

donation if you find the manual useful.

Camera information
Speaking of vintage cameras, Dr Jake L

Snaddon has recommended:

Camerapedia
http://www.camerapedia.org/wiki/

It’s the ‘Wikipedia’ of the camera world

and it has a fascinating and very

comprehensive range of information on

cameras of all sorts. It’s a really good

site which is well worth a visit and, if

you can’t find our own favourite camera

there, it’s a ‘wiki’ so you can start a

page on it.

An invitation
If you’d like your website to be featured

in future Webwise articles then please

email me at

davidfcookearps@gmail.com with

details of your site and let me have a

few words about your photography. It

could help to put you in touch with like

minded photographers.

Please do also let me know of any web

sites that you have found useful so I can

let other photographers know about

them by publishing the details here.

40 DIGIT Spring 2010  Webwise:448-471 Talbot  05/05/2010  16:41  Page 1



Tony Healy arps

41rPs DiGit Magazine spring 2010

e
veryone who is interested in

nature, be it animal, vegetable or

mineral or all three, has a list of

places for pilgrimages. the Galapagos

islands, Colorado Plateau, frozen Poles,

iguasu Falls, etc. one of the places on

my list was the inside Passage, a strip of

seashore along the south-western coast of

Alaska, 500 miles (800km) long and 100

miles (160km) wide. it has been a goal

of mine for some time and, since i first

listed it, cruises in the area have become

really big business. Huge liners carrying

up to 3,000 and 4,000 people sail out of

seattle heading for Juneau and

eventually, seward, the sea port of

Anchorage. i like people, but not quite

that many at once. My preference was

for something a bit more intimate and my

wife and i chose a company called

Cruise West, that used a small vessel,

which held a maximum of 100 people,

with whom to do the cruise. 

the cruise covered about 1000 miles,

visiting ketchikan, Misty Fjords,

Metlakatla, Petersburg, tracey Arm,

sitka, Glacier Bay National Park,

tony Healy has wanted to go to Alaska for some time and has recently

fulfilled his ambition. three of the panorama images from his trip were

published on page 46 of DiGit, issue No 44. in this article, he describes

the cruise he took there and shows us some more of the images he made.

skagway. Haines and Juneau. to reach

these destination the ship wound its way

in between and around islands, into

fjords for close ups of the verdant

landscape and views of local animals that

may appear. on this trip the ship only

had 81 passengers and apart from the

events manager, there was only one other

serious photographer than me. For shots

of the sea animals and birds we saw he

used an f2/300mm lens with a 2x

extender. the lens was huge and he had

it attached to a monopod to hold it

steady. A lot of his marine shots were

taken at iso 1600. My top speed was

iso 800 and 200mm lens. i didn’t think

A Cruise to AlAskA

John Hopkins Glacier, Glacier Bay

Petersburg
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­to­take­my­2x­extender.­Shots­of­some

very­small­marine­birds­did­push­RAW

shots­and­Photoshop­to­the­limits.­Every

cabin­window­had­two­pairs­of

binoculars­available­for­use­and­every

window­in­the­lounge­area­had­3­pairs

for­use­by­the­passengers­to­get­close­up

views­of­the­animals.

The­company­said­we­could­see­whales,

orcas,­bald­eagles,­seals,­sea­otters,

puffins,­black­bears,­Grizzly­bears­and

mountain­goats,­and­the­captain­did

everything­he­could­to­make­sure­we­not

only­saw­them­but­had­plenty­of­time­to

photograph­them.­As­every­photographic

traveller­knows­you­are­at­the­mercy­of

the­weather­on­any­trip­and­this­was­no

exception.­Some­mornings­started­out

very­cloudy­and­dull.­In­most­cases­it

did­brighten­up­during­the­day­but­not

always­in­time­for­a­particular

photograph.­The­morning­we­entered

Glacier­Bay­was­one­such­day­and­the

Park­Ranger­we­took­on­board,­said,­“I

must­apologise.­I­know­you­people­have

come­to­view­the­Bay­in­its­natural­state,

but­the­weather­bureau­says

unfortunately­we­will­get­some­sunshine

this­afternoon.”­

Misty­Fjords­lived­up­to­its­name­and­I

don’t­think­I­would­have­wanted­to­visit

it­without­the­mist.­It­was­a­magical

moment­to­glide­slowly­down­the­fjord

on­a­sea­of­glass­and­watch­the

waterfalls­come­and­go.­Apart­from­the

animals­there­is­the­landscape­to­see.

Alaskan­law­forbids­the­logging­of­more

than­5%­of­the­forests,­which­means­this

scenic­area­should­be­around­for­quite­a

while.­As­well­as­showing­visitors­the

land­and­its­animals,­the­founder­of

Cruise­West,­was­also­keen­that­people

should­be­educated­about­the­history­and

culture­of­Alaska.­For­that­reason­the

itinerary­included­visits­to­the­townships

of­Metlakatla,­Petersburg­and­Sitka­and

the­meeting­with­native­people­who

really­have­been­living­here­for

thousands­of­years.­

The­cruise­also­includes­an­option­to

visit­Denali­National­Park­on­the

mainland­with­an­excursion­into­the

interior.­Originally­we­had­planned­this

as­well,­but­when­the­financial­crisis

broke­and­the­exchange­rate­of­our

dollar­dropped,­we­had­to­modify­our

plans.­­We­found­that­the­Alaska

Railroad­had­a­travel­package­called

“Denali­in­a­Day”.­It­constituted­Gold

Star­train­travel­from­Anchorage­to

Talkeetna,­for­an­afternoon­flight­around

Tufted Puffin (Fratecula cirrhata)

Bald Eagle at Nest
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Misty Fjords at Low Tide

South Sawyer Glacier
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Mt. McKinley, flying within 6 miles of

the summit and a tour over the glaciers

of Denali National Park and the entire

south side of Denali and the Alaska

Range. Once again a clear view is

dependent on the weather. Mt.

McKinley is only clear of cloud for

about 20% of the time. Our flight was

one of the cloudy ones, but the peak did

clear before we returned to the airport so

we did see the top of Mt. McKinley.

After the flight you are returned to

Talkeetna to have lunch and a wander

around the town catching the train about

4 pm to arrive back in Anchorage at 8

pm.

Alaska Railroad has a train departing

Anchorage and Fairbanks every day at

8am arriving at their destinations at

8pm. The carriages have glass tops and

a glassless observation platform if you

Denali Ice Fields

Glacier Surface, Juneau
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want to take photographs without

reflections. The train travels through

interesting scenery and some of the

shipping companies have their own

carriages for their clients. These carriages

don’t appear to have a clear observation

platform.

We decided to do a round trip including

the flight, and utilised B & Bs in

Anchorage, Talkeetna and Fairbanks.

One of the attractions for me was that we

passed through the coal mining centre of

HEALY, and the dining car on the train

offered a “Healy Miner’s Sandwich” for

lunch. It was a bit more substantial than

a Ploughman’s Lunch. Due to these two

modes of transport on this trip most

photographs were taken from a moving

platform. The morning after our flight in

Talkeetna, Mt. Kinley’s peak was visible

and continued to be so as the train took

us to Fairbanks. Returning to Anchorage

the next day the Denali range was even

clearer than the day before, so for the 3

days we were in sight of Mt. McKinley,

we saw and photographed the peak.

Eagle Totem

Petersburg Children in Norwegian Costume
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Humpback Whale

Stellar Sea Lions (Eumetopas j  ubatus)
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Alaskan Twilight

Cormorant Colony (Phalacrocorax pelagicus)
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